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1 What You Need To Know Before You Read This Document 

Before reading this document you should be familiar with the material in the TReK 

Getting Started User Guide (TREK-USER-001).  If you have not read this document, you 

may have difficulty with some of the terminology and concepts presented in this 

document. 

 

We assume you are an experienced Windows user.  Information about how to use a 

mouse or how to use Windows is not addressed in this user guide.  Please see your 

Windows documentation for help with Windows. 

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK software 

applications, please try the following suggestions: 

 

Read the appropriate material in the manual and/or on-line help. 

 

Ensure that you are correctly following all instructions. 

 

Checkout the TReK Web site at http://trek.msfc.nasa.gov/ for Frequently Asked 

Questions. 

 

If you are still unable to resolve your difficulty, please contact us for technical assistance: 

 

TReK Help Desk E-Mail, Phone & Fax: 

 

E-Mail:  trek.help@nasa.gov 

Telephone:  256-544-3521 (8:00 a.m. - 4:30 p.m. Central Time) 

Fax:   256-544-9353 

 

TReK Help Desk hours are 8:00 a.m. – 4:30 p.m. Central Time Monday through Friday.  

If you call the TReK Help Desk and you get a recording please leave a message and 

someone will return your call.  E-mail is the preferred contact method for help.  The e-

mail message is automatically forwarded to the TReK developers and helps cut the 

response time. 

 

 

3 Introduction 

The TReK Remote Services application is used to configure TReK to accept remote 

connections from external TReK systems.  Using this application you can configure 

security settings, create user accounts, and track remote connections.  One of the terms 

that will be used frequently in this document is the term “sentinel”.  In a conceptual sense 

a sentinel is both a guard and a gateway.  You create a sentinel to allow remote TReK 
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users to connect and use your TReK services.  As a guard the sentinel evaluates each 

incoming connection and only accepts the connection if it meets the current security 

configuration criteria.  As a gateway, the sentinel provides the passageway for incoming 

connections and requests for services.  In a technical sense a sentinel is basically a 

network socket (TCP listener socket).  It is possible to create multiple sentinels and you 

can define which network card to use when you create a sentinel.  Each sentinel can 

support multiple remote connections.  Each time a remote user connects to a sentinel, the 

sentinel uses the current security configuration to determine whether to accept the 

connection.  If the connection meets the security criteria the connection is accepted.  If 

not it is rejected.  There are three security configurations each offering various levels of 

security:  Allow All Connections, Check Source IP Address Only, and Login Required.  

Detailed information about each security configuration is described later in this 

document. 

 

 

4 Remote Services Main Window 

The Remote Services main window consists of two main areas as shown in Figure 1.  The 

top part of the main window contains the list of sentinels identified by your TReK 

system.  When you start the Remote Services application the list will be empty.  This is 

because you have not yet added any sentinels to the list.  The bottom part of the window 

is a message area that is used to display important status and error information messages 

about the remote service activities in progress. 

 

 

Figure 1 Remote Services Main Window 

 

There are four pieces of information that are displayed for each sentinel in the sentinel 

list.  They are Sentinel Name, Sentinel Recording, Sentinel Status, and # Remote 

Connections.  The Sentinel Name is a user-defined name given to the sentinel when it is 
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created.  The Sentinel Recording column identifies whether the information flowing 

across the connection is being recorded.  The Sentinel Status column identifies the status 

of the sentinel.  The # Remote Connections column identifies how many remote 

connections are being supported by the sentinel. 

 

If you are running the Remote Services application or viewing this document from within 

Microsoft Word then you have probably noticed that the sentinel row has a color 

associated with it.  The color provides information about the sentinel.  For example, when 

using the default colors, if the sentinel row is black, this indicates that the sentinel has not 

been activated.  If the sentinel row is purple, this indicates that the sentinel is initializing.  

If the sentinel row is green, this indicates that the sentinel is ready to accept connections.  

The colors are helpful in providing immediate information about the general 

configuration and status of each sentinel in the list. 

 

 

5 Remote Services Menus 

The Remote Services application contains five main menus:  File, View, Sentinel, 

Options, and Help.  Each of these menus is described in more detail below. 

 

5.1 File Menu 

The File menu is used to create, open, and save remote services configurations and to exit 

the Remote Services application.  A Remote Services configuration is comprised of the 

sentinels in the sentinel list along with all the information associated with each sentinel.  

This includes the color preferences you set in the Set Color Preferences dialog.  When 

you save a configuration, the Remote Services application will default to the 

<base_path>\configuration_files\remote_services directory.     

 

If the operating system is installed in the default directory on the C drive then: 

 

<base_path> = C:\Documents and Settings\<username>\Application Data\TReK 

 

You can save your configuration files anywhere you like, but this default directory 

provides an easy way for you to keep up with your files.   

 

Each of the items on the File menu is described below.  

 

New 

New provides a way to start a new configuration.  When you start a new configuration 

any sentinels in the list are deleted and all activities associated with those sentinels are 

stopped.  If there are unsaved sentinels in the sentinel list when New is selected, you will 

be given the option of saving the configuration before all the sentinels are deleted from 

the sentinel list.  The New menu item will be insensitive when there are sentinels in the 

sentinel list which are initializing.  As soon as the sentinel(s) finish initializing the menu 

item will be available. 
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Open 

Open provides a way to open a previously saved configuration.  The Open menu item 

will be insensitive when there are sentinels in the sentinel list which are initializing.  As 

soon as the sentinel(s) finish initializing the menu item will be available. 

 

Save 

Save provides a way to save the current configuration. The Save menu item will be 

insensitive when there are sentinels in the sentinel list which are initializing.  As soon as 

the sentinel(s) finish initializing the menu item will be available. 

 

Save As 

Save As provides a way to save the current configuration with another name.  The Save 

As menu item will be insensitive when there are sentinels in the sentinel list which are 

initializing.  As soon as the sentinel(s) finish initializing the menu item will be available. 

 

Exit 

Exit provides a way to exit the Remote Services application.  The Exit menu item will be 

insensitive when there are sentinels in the sentinel list which are initializing.  As soon as 

the sentinel(s) finish initializing the menu item will be available. 

 

 

5.2 View Menu 

The View menu is used to change attributes associated with the Remote Services main 

window.  There are three items on the View menu.  Each is described below: 

 

Status Bar 

The Status Bar is located at the very bottom of the Remote Services main window.  The 

status bar is used to display messages and useful information to you without interrupting 

your work.  The status bar has "panes," which include "indicators" and a "message line."  

The indicators provide the status of items such as SCROLL LOCK. The message line on 

the status bar can display information about program status or about a toolbar button or 

menu item that you are pointing to with the mouse.  The status bar will always display the 

current security configuration (e.g. Login Required).  If you select the Status Bar item on 

the View menu, this will toggle the Status Bar on and off. 

 

Set Color Preferences 

The Set Color Preferences option brings up the Set Color Preferences dialog.  This dialog 

can be used to turn off, turn on, or change the colors used in the Remote Services main 

window. 
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Clear Message Area 

As mentioned in section 4, the message area is located at the bottom of the Remote 

Services main window.  This is where important status and error messages will be 

displayed while you are working with the application.  If you select the Clear Message 

Area item on the View menu, this will clear all the messages in the Message Area.  Once 

they have been cleared, you cannot get them back. 

 

5.3 Sentinel Menu 

The Sentinel menu is the most frequently used menu in the Remote Services application.  

It is used to add sentinels to the sentinel list in the main window, and to control all the 

activities associated with each sentinel.  Each of the items on the Sentinel menu are 

described below. 

 

Add Sentinel 

Used to add a sentinel.  When you select Add Sentinel, a dialog box will be presented so 

that you can fill in the information your TReK system needs in order to know how to 

identify and create the sentinel. 

 

Activate Sentinel 

Used to tell Remote Services to activate the sentinel and prepare to evaluate incoming 

connections from remote TReK systems. The Activate Sentinel option is only available 

when you have a sentinel selected that is not activated (i.e., Sentinel Status is Inactive.) 

 

Start Recording 

Used to tell your TReK system to start recording the data flowing across the connections 

supported by a particular sentinel.  (Recording can be set up when you initially add a 

sentinel to the list, but if you don’t specify recording at that time it can be added later 

using this menu option).  The Start Recording option is only available when you have a 

sentinel selected with a Recording Status of Off or Stopped. 

 

Pause Recording 

Used to tell your TReK system to pause recording for a particular sentinel.  Please note 

that this will only pause recording.  The Pause Recording option is only available when 

you have a sentinel selected with a Recording Status of Recording. 

 

Resume Recording 

Used to tell your TReK system to resume recording for a particular sentinel. The Resume 

Recording option is only available when you have a sentinel selected with a Recording 

Status of Paused. 

 

Stop Recording 

Used to tell your TReK system to stop recording a particular sentinel. The Stop 

Recording option is only available when you have a sentinel selected with a Recording 

Status of Recording or Paused. 
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View Realtime Messages 

Used to tell your TReK system to display the realtime messages associated with the 

connections supported by a particular sentinel. 

 

Deactivate Sentinel 

Used to tell your TReK system to shutdown the services associated with a particular 

sentinel.  When you select a sentinel in the sentinel list, and then select the Deactivate 

Sentinel option, the sentinel will be deactivated and your TReK system will stop services 

associated with that particular sentinel.  Any other activities associated with that sentinel 

such as recording or viewing will also stop because your TReK system will no longer be 

running services associated with that sentinel.  Any remote connections supported by that 

sentinel will be dropped.  The Deactivate Sentinel option is only available when you have 

an active sentinel selected.  If you want to delete the sentinel from the list, use the Delete 

Sentinel option. 

 

Delete Sentinel 

Used to tell your TReK system to shutdown and delete the selected sentinel.  When you 

select a sentinel in the sentinel list, and then select the Delete Sentinel option, the sentinel 

will be removed from the list and your TReK system will stop the services associated 

with that sentinel.  Any remote connections supported by that sentinel will be dropped.  

The Delete Sentinel option is only available when you have a sentinel selected. 

 

Show Sentinel Properties 

Used to see a complete list of properties about a particular sentinel.  This includes 

information such as the Sentinel Name, Recording Properties, etc.  The sentinel 

properties are defined when you add the sentinel to the sentinel list using the Add 

Sentinel dialog. 

 

5.4 Options Menu 

The Options menu is used to access information about general remote services attributes 

and specific remote services status information.  Each of the items on the Options menu 

is described below. 

 

Set Security Configuration 

Used to set the security configuration and define TReK user accounts. 

 

Set Remote Services Options 

Used to set Remote Services application options such as the default directory to be used 

for Remote Services configuration files. 

 

Show Remote Services Statistics 

Used to view specific remote services network statistics information.  This includes 

information such as the number of packets received, the number of packets sent, if any 

packets were dropped, the number of connections, etc. 
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Recorded Data Viewer 

Provides access to the Recorded Data Viewer.  The Recorded Data Viewer is used to 

view information stored in a TReK recording file. 

 

5.5 Help Menu 

The Help menu is used to access on-line help for the Remote Services application. Each 

of the items on the Help menu is described below. 

 

Help Topics 

Used to access the typical Windows Contents and Index on-line help window. 

 

About Remote Services 

Used to view the About Remote Services dialog. 

 

5.6 Sentinel List Pop-Up Menu 

The Sentinel List pop-up menu can be accessed by clicking the right mouse button in the 

sentinel list area of the main window.  If you right click in the sentinel list area of the 

window, but you do not click on a sentinel in the list, many of the menu items will be 

insensitive.  This is because many of the menu items are only applicable when a sentinel 

is selected.  If you right click on a sentinel in the sentinel list all the menu items which 

are applicable to that particular sentinel at that moment in time will be sensitive.  The 

Sentinel List Pop-Up menu is identical to the Sentinel menu on the menu bar. 

 

5.7 Windows Edit Pop-Up Menu 

The standard Windows Edit Pop-Up Menu can be accessed whenever your cursor is 

located inside an edit field inside the Remote Services application.  This menu contains 

the standard edit commands such as Cut, Copy, and Paste. 

 

 

6 Remote Services Dialog Boxes 

This section describes all the dialog boxes in the Remote Services application.  For an 

example of how some of these dialogs are used while working with the Remote Services 

application please see the TReK Command Management Tutorial (TREK-USER-036). 

 

6.1 Set Color Preferences Dialog 

The Set Color Preferences dialog is shown in Figure 2 below.  It is used to control the 

color feature associated with the Remote Services main window sentinel list.  The color 

of a sentinel in the sentinel list indicates the sentinel’s status.  The color feature can be 

turned off.  If it is off, the sentinels in the sentinel list will always be black.  If the color 

feature is on, the sentinels in the sentinel list will turn a specific color based on the 

sentinel status and the colors assigned in the Set Color Preferences dialog. 
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Figure 2 Set Color Preferences Dialog 

 

 

 

Each field and control on the Set Color Preferences dialog is described below. 

 

Color On 

Turns the color feature on. 

 

Color Off 

Turns the color feature off. 

 

No Status Color 

The color assigned when the status of the sentinel is “Inactive”.  “Inactive” indicates that 

there is no information available about the sentinel.  This will be the case when the 

sentinel has been added to the sentinel list but it has not been activated.  In this situation, 

your TReK system has not been told to do anything about the sentinel and therefore has 

no status information about the sentinel.   (Default Color: Black) 

 

Initializing Color 

The color assigned when the status of the sentinel is “Initializing”.  This status will occur 

when the sentinel is in the process of activating. (Default Color: Purple) 

 

Active Color 

The color assigned when the status of the sentinel is “Active” or ready to accept 

connections.  This status will occur when the sentinel has been activated. (Default Color: 

Green) 

 

Error Condition Color 
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The color assigned to a sentinel when an unknown error occurs.  (Default Color: Red) 

 

Buttons 

 

Select Color 

The Select Color button is used to access the standard Windows Color dialog in order to 

change the assigned color. 

 

Set to Defaults 

The Set to Defaults button will reset all the fields and controls in the Set Color 

Preferences dialog box to the original values that were in place when the TReK software 

was installed. 

 

6.2 Add Sentinel (General Tab) Dialog 

The Add Sentinel dialog is used to add a sentinel to the sentinel list in the main window.  

Remember you create a sentinel to accept connections from remote TReK systems.  

Sentinels are uniquely identified by the Sentinel Name.  As can be seen in Figure 3 there 

are two tabs in the Add Sentinel dialog. The General tab is divided into two sections: 

General Information and Communication Information.  The General Information section 

contains general information such as the sentinel name.  The Communication Information 

section tells your TReK system what IP address and port number to use when creating the 

sentinel (network socket).  The Browse button next to the Local IP Address field can be 

used to see a list of all the available IP addresses on your machine.  This can be helpful if 

you have more than one network card installed. 

 

 

 

Figure 3 Add Sentinel (General Tab) Dialog 
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Each field on the General Tab of the Add Sentinel dialog is described below. 

 

Name (Required Field) 

The name field is used to tell your TReK system the name of your sentinel. 

 

Local IP Address   (Required Field) 

The Local IP address field is used to tell your TReK system what IP address (or network 

card) to use when creating the sentinel.  The IP Address field will automatically default to 

your local unicast IP address.  If you want to see a list of all the IP addresses for your 

machine, just push the Browse button next to the IP address field.  Your TReK system 

retrieves your local unicast IP address from the Windows registry.  If you are not familiar 

with the registry, don’t worry about it.  You don’t need to be familiar with the registry to 

use your TReK system.   

 

If your machine does not have network connectivity (such as no ethernet card or modem 

or the system is not connected to a network), set the IP address to 127.0.0.1.  This is 

called a loopback address and can be used while you are working in standalone mode.  

This would really only be useful when you are learning to use the Remote Services 

application and/or the Command Management capability.  Since the purpose of the 

Remote Services application is to accept connections from remote systems, it isn’t very 

useful if you’re not connected to a network. 

 

Local Port (Required Field) 

The Local Port is used to tell your TReK system which port to use when creating the 

sentinel.   

 

Note:  When you are ready to work with your remote users, you will need to give them the 

IP Address and Port number of your sentinel.  This is information they will enter into their 

TReK system when trying to establish a network connection with your TReK system.  While 

TReK provides a default port number for sentinels (10100), you may want to consider 

selecting a different port number.  By doing this you can minimize the number of people who 

know what port number you are using thereby making your system more secure. 

 

6.3 Add Sentinel (Options Tab) Dialog 

The Options Tab, shown in Figure 4, provides a way to configure optional sentinel 

services.  The Options tab is divided into two sections:  Sentinel Message Recording and 

Sentinel Message Viewing.  The Sentinel Message Recording section is used to identify 

whether the messages sent to/from remote users should be recorded and if so where the 

recorded messages should be stored.  The Sentinel Message Viewing section is used to 

configure properties associated with viewing the messages sent to/from remote users.  

This is how you identify how many messages should be displayed in the View Realtime 

Sentinel Messages dialog.  If you turn viewing off, you will still be able to bring up the 

View Realtime Sentinel Messages dialog, but no messages will be displayed in the 

dialog. 
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Figure 4 Add Sentinel (Options Tab) Dialog 

 

Each field on the Options Tab of the Add Sentinel dialog is described below. 

 

Recording  (Required Field) 

The Recording option is used to tell your TReK system whether the data flowing across 

the connections supported by the sentinel should be recorded. 

 

Base Filename  (Required Field if Recording is On) 

When your TReK system records the data flowing across the connections supported by 

the sentinel, the raw data is stored in one or more files in a local directory.  A base 

filename (provided by you) is used as the base name of the file and the rest of the file 

name is generated by your TReK system.  The complete filename indicates the time the 

file was created and closed.  It’s a good idea to select a meaningful name that will be easy 

to remember and is closely associated with the data that you are recording. 

 

Directory  (Required Field if Recording is On) 

The Directory information is used to tell your TReK system which directory should be 

used when storing your data recording files.  When you want to view the recorded data, 

you will be asked to provide this Directory information so your TReK system can find 

the files.  This field requires a complete directory path.  An example of this is 

c:\MyRecordingFiles\.  If you don’t like to type or you need help defining the 

complete path, you can push the … (dot dot dot) button located to the right of the 

Directory field.  This will bring up a Windows Browse for Folder dialog which you can 

use to identify the local directory path where you want to store your recorded data files.  

The Browse for Folder dialog is not described in this document since it is a typical 

Windows dialog box.  If you need help with this dialog, please refer to your Windows on-

line help. 

 

Viewing (Required Field) 
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The Viewing option is used to tell your TReK system whether the realtime messages 

associated with the sentinel’s connections should be available for viewing.  Viewing does 

use CPU and memory resources.  Therefore, remember that if you start to run low on 

resources it is possible to turn viewing off. 

 

Buffer Size (# Messages) (Required if Viewing is On) 

The Buffer Size tells your TReK system how many realtime messages to store in memory 

at a time.  The buffer will wrap and older messages will be overwritten.  This is a 

safeguard against using up too much memory. 

 

6.4 Browse for IP Address Dialog 

The Browse For IP Address dialog is shown in Figure 5.  This dialog is used to search a 

TReK system for all IP addresses or network cards associated with the system.  

 

Figure 5 Browse For IP Address Dialog 

 

 

Each field in the Browse For IP Address dialog is described below. 

 

Please select an IP Address: (Required Field) 

You have two options when choosing an IP address.  If your TReK system does not have 

network connectivity (such as no ethernet card or modem or the system is not connected 

to a network), you need to use the standard loopback address (127.0.0.1).  This option is 

provided by choosing the “Loopback Address: 127.0.0.1” radio button.  Users with one or 

more network cards will need to choose which network card or IP Address they would 

like to use.  Choosing the “IP Address List” radio button provides this option.  The user 

must then select an IP address from the list. 

 

IP Address 
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The IP Address field is filled in when you select the Loopback IP address or an IP 

Address in the list.  The IP Address will be copied to the dialog box that contained the 

button you used to bring up the Browse For IP Address dialog. 

 

6.5 Sentinel Properties Dialog 

The Sentinel Properties dialog is used to view and modify sentinel properties.  The 

sentinel properties are defined when you add the sentinel to the sentinel list using the Add 

Sentinel dialog.  The Show Sentinel Properties dialog is identical to the Add Sentinel 

dialog.  If the sentinel is active, some of the fields will be insensitive because they cannot 

be modified. 

 

 

Figure 6 Sentinel Properties Dialog 

 

6.6 Enter Recording Information Dialog 

The Enter Recording Information dialog is shown in Figure 7.  This dialog will appear 

when you select Start Recording from the Sentinel Menu or Sentinel List pop-up menu.  

You use this dialog to tell your TReK system where you want to store your recording 

files and what you want to use for the Base Filename. 

 

 

 

Figure 7 Enter Recording Information Dialog 
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Each field in the Enter Recording Information dialog is described below. 

 

Base Filename  (Required Field) 

When your TReK system records data, the raw data is stored in one or more files in a 

local directory.  A base filename (provided by you) is used as the base name of the file 

and the rest of the file name is generated by your TReK system.  The complete filename 

indicates the time the file was created and closed.  It’s a good idea to select a meaningful 

name that will be easy to remember and is closely associated with the data that you are 

recording. 

 

Directory  (Required Field) 

The Directory information is used to tell your TReK system which directory should be 

used when storing your recording files.  This field requires a complete directory path.  An 

example of this is C:\MyRecordingFiles\.  If you don’t like to type or you need help 

defining the complete path, you can push the … (dot dot dot) button located to the right 

of the Directory field.  This will bring up a Windows Browse for Folder dialog which you 

can use to identify the local directory path where you want to store your recorded data 

files.   

 

The Browse for Folder dialog is not described in this document since it is a typical 

Windows dialog box.  If you need help with this dialog, please refer to your Windows on-

line help. 

 

 

Dialog Buttons 

There is one non-standard button on the Enter Recording Information dialog box.  It is 

described below. 

 

Advanced 

The Advanced button displays the Advanced Recording Properties dialog.  This dialog is 

described in section 6.7. 

 

6.7 Advanced Recording Dialog 

The Advanced Recording dialog is shown in Figure 8.  This dialog will appear when you 

select the Advanced button located next to a Sentinel Recording option.  This could be in 

the Add Sentinel dialog or the Enter Recording Information dialog.  You use this dialog 

to tell your TReK system what recording properties to use for a particular recording 

activity. 
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Figure 8 Advanced Recording Dialog 

 

Each field in the Advanced Recording dialog is described below. 

 

Maximum File Size (bytes)  (Required Field) 

The Maximum File Size information is used to determine when to close a recording file.  

This property is always used. 

 

Maximum Time File Is Open (minutes) 

The Maximum Time File Is Open Checkbox is used to indicate whether the file should be 

closed based on a maximum time.  This is an optional property.  If you check the 

checkbox then this property will be used.  If you check the box, then you must also fill in 

the text field with the amount of time in minutes that should be used as the maximum 

time.  The Maximum Time File Is Open property is used in addition to the Maximum File 

Size property.  If the maximum size is reached before the maximum time, then the file 

will be closed based on the size.  However, if the maximum time is reached before the 

maximum size is reached, the file will be closed based on the maximum time. 

 

Maximum Time Directory Is Open 

The Maximum Time Directory Is Open Checkbox is used to indicate whether recording 

files should be placed in sub-directories within the parent base directory.  The directories 

will be open/closed based on Day, Week, Month, or Year.  This is an optional property.  

If you check the checkbox then this property will be used. 

 

6.8 View Realtime Sentinel Messages (Sentinel Name) Dialog 

The View Realtime Sentinel Messages dialog is shown in Figure 9.  This dialog displays 

the realtime sentinel messages that were sent back and forth between the sentinel and a 

remote TReK system.   The messages are formatted to show the TReK Receipt Time 

(TRT) associated with the message, the hexadecimal representation of the message, and 

other sentinel/message specific information. 
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Figure 9 View Realtime Sentinel Messages Dialog 

 

 

Buttons 

There are several non-standard buttons on the View Realtime Sentinel Messages dialog 

box.  Each is described below. 

 

Pause 

The Pause button will pause the display of any incoming messages.  Since the realtime 

messages are stored in a buffer it is possible for the buffer to wrap while the display is 

paused.  Therefore, when you push the Resume button you may see some of the messages 

that arrived while the display was paused or some may be missing because the buffer 

wrapped. 

 

Resume 

The Resume button will resume display of any incoming messages. 

 

Clear 

The Clear button will clear the display and the underlying buffer where the realtime 

messages are stored.  Therefore, if you push the Clear button, all the realtime messages 

that TReK currently has stored in the buffer and the window will be deleted.  However, 

any new messages that arrive after you push the clear button will be stored in the buffer 

and displayed in the realtime message viewer window.  (Note:  If you are recording 

incoming messages they will always be stored to disk.  So even if you push the clear 

button in a realtime viewer window this does not affect data that is being recorded to 

disk.  You can use the Recorded Data Viewer to view messages that have been recorded 

in a file.) 

 

Note:  Passwords are not displayed in the View Realtime Sentinel Messages dialog. 
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6.9 Set Security Configuration Dialog 

The Set Security Information dialog is shown in Figure 10.  This dialog provides a way to 

set the security configuration that will be used for all incoming connection requests.  

TReK supports three levels of security.  The lowest (most minimal) level of security is 

“Allow All Connections”.  This configuration automatically accepts all incoming 

connections.  No source IP address checks are performed and no login is required.  Please 

note that services such as command destination services are configured separately and 

may not be available even if the connection is allowed.  The second level of security is 

“Check Source IP Address Only”.  This configuration will only check the source IP 

address for the remote party requesting to connect.  If the IP address is in the list of 

approved addresses, then the connection will be accepted.  If not, the connection will be 

rejected.  The third level of security (maximum level) is Login Required.  This 

configuration requires the remote party to enter a username and password.  The user 

account can be configured to check the source IP address or to allow the user to connect 

from any IP address.  This is the safest security configuration. 

 

For more information about how the security configuration affects the command 

management capability please reference the TReK Command Management Tutorial 

(TREK-USER-036). 

 

Note:  TReK only provides encryption on the data zone of messages associated with the 

sentinel.  Security services such as VPN must be implemented by the user or supporting 

control center. 
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Figure 10 Set Security Configuration Dialog 

 

Each field in the Set Security Configuration dialog is described below. 

 

Security Configuration (Radio Buttons) 

There are three security configurations:  Allow All Connections, Check Source IP 

Address, and Login Required. 

 

IP Address List 

This is the global IP Address list that is used when the security configuration is set to 

“Check Source IP Address”.  This list is only used with the “Check Source IP Address” 

configuration.  The Add button is used to add IP Addresses to the list and the Delete 

button is used to Delete addresses from the list. 

 

Buttons 

The Add button provides a way to add an IP address to the list.  The Add IP Address 

dialog is described in Section 6.10.  The Delete button provides a way to delete an IP 

address from the list. 

 

Login Required User Account List 
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The List under the Login Required radio button shows a list of all TReK user accounts.  

This list displays the username, account enable/disable status, and a short description for 

each account. 

 

Buttons 

The Add button can be used to add a user account.  The Add User Account dialog is 

described in section 6.11.  The Modify button can be used to Modify a user account.  The 

Delete button can be used to delete a user account.  The Options button can be used to set 

account password rules.  The Options (Login Required Configuration) dialog is described 

in Section 6.12.  Please remember that these user accounts have no relation to the 

computer’s user accounts (created using the operating system).  TReK user accounts are 

completely separate and independent. 

 

6.10 Add IP Address Dialog 

The Add IP Address dialog is shown in Figure 11.  This dialog is used to add an IP 

address to the Check Source IP Address Only IP address list in the Set Security 

Configuration dialog or for IP address checks in the Add User Account dialog.   

 

 

 

Figure 11 Add IP Address Dialog 

 

 

Each field in the Add IP Address dialog is described below. 

 

IP Address (Required) 

The IP Address to add to the list. 

 

6.11 Add User Account Dialog 

The Add User Account dialog is shown in Figure 12.  This dialog is used to add a user 

account to the list of user accounts in the Set Security Configuration dialog.  The 

Username and Password information is case sensitive.  So when a remote user logs in, 

they need to enter the username and password information exactly as you define it in this 

dialog.  
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Figure 12 Add User Account 

 

 

 

Each field in the Add User Account dialog is described below. 

 

 

Username (Required) 

The username for the account. 

 

Password (Required) 

The password for the account. 

 

Verify Password (Required) 

The data in this field must match the data in the Password field. 

 

Account (Required) 

Each user account can be set to Enabled or Disabled.  If the account is Disabled, and a 

remote user attempts to connect using this account’s username, the connection will be 

rejected. 

 

Description 

A brief description of the account.  This description will be displayed in the Set Security 

Configuration dialog’s user account list. 
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Allow User To Connect From Any IP Address 

If this option is selected, a user logging in using this account can connect from any IP 

address and no source IP address check will be performed. 

 

Check User’s IP Address Against This List 

If this option is selected, a source IP address check will be performed when a user logs in 

using this account.  The source IP address will be checked against the list of IP addresses 

listed under this radio button. 

 

Buttons 

The Add button provides a way to add an IP address to the list.  The Delete button 

provides a way to delete an IP address from the list. 

 

 

IP Address List (Required if Check User’s IP Address Against This List is checked) 

This list contains the list of source IP addresses that are approved for this user.  If the 

“Check User’s IP Address Against This List” is selected and the user attempts to connect, 

the user’s source IP address will be compared to the addresses on this list.  If the source 

IP address is on this list the connection will be accepted.  Otherwise the connection will 

be rejected.  The Add button can be used to add IP addresses to the list.  The Delete 

button can be used to delete IP addresses from the list. 

 

6.12 Options (Login Required Configuration) Dialog 

The Options (Login Required Configuration) dialog is shown in Figure 13.  This dialog 

provides a way to enforce password rules for each user account.  By default, none of 

these rules are enforced.  To enforce a rule, select the checkbox next to the rule. 

 

 

Figure 13 Options (Login Required Configuration) Dialog 

 

Each field in the Options (Login Required Configuration) dialog is described below. 
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Password Must Contain Minimum Number Characters: 

If this rule is selected, then all passwords entered must contain at least the number of 

characters specified in the field.  This will not cause current passwords failing to meet the 

rule to be reset. 

 

Password Must Contain Special Characters 

If this rule is selected, then the password must contain characters from at least three of 

the following four categories:  lower case letters, upper case letters, numbers, and special 

characters (for example, the dollar sign ‘$’).  This will not cause current passwords 

failing to meet the rule to be reset. 

 

Password Must Not Match Username 

If this rule is selected, then the password must be different than the username.  This will 

not cause current passwords failing to meet the rule to be reset. 

 

Password Must Meet Maximum Lifetime Requirement (Days) 

If this rule is selected, then the password must be changed after the specified number of 

days.  An expired password can be changed during login.  The age of the password is 

maintained even if this field is not selected.  Therefore, when selected, the password age 

begins from the last time the password was set. 

 

6.13 Set Remote Services Options Dialog 

The Set Remote Services Options dialog is shown in Figure 14.  This dialog provides a 

way to set application defaults.  For example, you can set the default directory for remote 

services configuration files. 

 

 

 

Figure 14 Set Remote Services Options Dialog 

 

 

Each field in the Set Remote Services Options dialog is described below.  

 

Remote Services Configuration Files Default Directory 

This property provides a way to set a user-specified default directory for configuration 

files.  You can leave this field blank.  If you leave it blank, TReK will use the following 

directory:    
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<base_path>\configuration_files\remote_services 

 

The <base_path> on a Windows 2000 computer is shown below. 

 

<base_path> = C:\Documents and Settings\<username>\Application Data\TReK 

 

 

Buttons 

There is one non-standard button on the Set Remote Services Options dialog.  It is 

described below. 

 

Set to Defaults 

The Set to Defaults button will reset all properties in the dialog box to the original values 

that were in place when the TReK software was installed. 

 

6.14 Remote Services Statistics 

The Remote Services Statistics dialog is shown in Figure 15.  This dialog provides 

statistics information about the remote services work currently in progress.  For example, 

you can use this dialog to display information about the number of packets received, the 

number of packets sent, etc. 

 

 

 
 

Figure 15 Remote Services Statistics (Sentinel Tab) Dialog 

 

 

The Remote Services Statistics dialog is a tabbed dialog with two tabs:  Sentinel and Port.  

The Sentinel tab shows statistics for each of the sentinels that are currently in the main 

window sentinel list.  Please note that until a remote user has connected to a sentinel, the 

Sentinel tab will not show any statistics information.  The Port tab shows statistics for 

each of the ports that are currently in use.  Information displayed for a port shows a 

summary of all activity on the port.  If there are packets (command messages, command 
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responses, etc) arriving at the port other than the packets you expect (or are configured 

for) this will still be reflected in the port statistics information.  The Sentinel tab is shown 

in Figure 15.  There are nine columns of information that can be displayed in the Sentinel 

tab and ten columns of information that can be displayed in the Port tab.  The Port tab is 

shown in Figure 16. 

 

 

Figure 16 Remote Services Statistics (Port Tab) Dialog 

 

 

 

Buttons 

 

Select Columns 

There is a Select Columns button on each tab.  The Select Columns button is used to 

identify which columns should be displayed.  The Select Columns button on the Sentinel 

tab will display the Select Sentinel Statistics Columns dialog described in Section 6.15.  

The Select Columns button on the Port tab will display the Select Port Statistics Columns 

dialog described in Section 6.16.  

 

Reset 

The Reset button resets all statistics information to zero.  Statistics collection will resume 

from that point with the count starting at zero.  For example, suppose you have received 

700 packets (the value 700 will be in the Packets Received column).  If you push the 

Reset button, the Packets Received value will be reset to 0 and the 700 in the Packets 

Received column will be replaced with 0. 

 

 

6.15 Select Sentinel Statistics Columns Dialog 

The Select Sentinel Statistics Columns dialog is shown in Figure 17.  This dialog is used 

to configure the columns in the Sentinel tab of the Remote Services Statistics dialog. 

 



TREK-USER-037 

 25 

 

Figure 17 Select Sentinel Statistics Columns Dialog 

 

 

Each field in the Select Sentinel Statistics Columns dialog is described below. 

 

Sentinel Name  

Sentinel Name.  The Sentinel Name column cannot be hidden. 

 

 

Pkts Rcvd 

The number of packets received from the remote user system.  If you check the Pkts 

Rcvd button, the Pkts Rcvd column will be displayed. 

 

Rcvd Pkts Drop 

Rcvd Pkts Drop stands for Received Packets Dropped.  It is the number of packets that 

arrived from the remote user system that TReK dropped.  If you check the Rcvd Pkts 

Drop button, the Rcvd Pkts Drop column will be displayed. 

 

Pkts Sent 

The number of packets sent to the remote user system.  If you check the Pkts Sent button, 

the Pkts Sent column will be displayed. 

 

Send Pkts Drop 

Send Pkts Drop stands for Send Packets Dropped.  It is the number of packets that TReK 

attempted to send but dropped.  If you check the Send Pkts Drop button, the Send Pkts 

Drop column will be displayed. 

 

Rec Pkts Drop 
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Rec Pkts Drop stands for Record Packets Dropped.  It is the number of record packets 

that TReK dropped and therefore did not successfully store in the recording file.  If you 

check the Rec Pkts Drop button, the Rec Pkts Drop column will be displayed. 

 

View Pkts Drop 

View Pkts Drop stands for View Packets Dropped.  It is the number of packets that 

arrived from the remote user system that TReK dropped and therefore failed to display in 

the view realtime messages dialog.  If you check the View Pkts Drop button, the View 

Pkts Drop column will be displayed. 

 

Connected To IP Address 

Identifies the IP Address that the sentinel is connected to.  If you check the Connected To 

IP Address button, the Connected To IP Address column will be displayed. 

 

Connected To Port 

Identifies the port that the sentinel is connected to.  If you check the Connected To Port 

button, the Connected To Port column will be displayed. 

 

 

 

6.16 Select Port Statistics Columns Dialog 

The Select Port Statistics Columns dialog is shown in Figure 18.  This dialog is used to 

configure the columns in the Port tab of the Remote Services Statistics dialog. 

 

 
 

Figure 18 Select Port Statistics Columns Dialog 
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Each field in the Select Port Statistics Columns dialog is described below. 

 

IP Address 

The IP Address column cannot be hidden. 

 

Port (C/L/S) 

The Port column cannot be hidden.  The port column shows a set of ports that are being 

used by TReK sockets to receive and send packets.  A sentinel may have a Client, 

Listener, or Server (C/L/S) Socket/Port combination associated with it.  In some cases it 

is possible to have more than one socket/port associated with a sentinel.  For example, if 

TReK is configured to listen for TCP connection requests on a particular port (which you 

identified when you added the sentinel) and a connection was established, the port 

column on the port tab will show two entries corresponding to the sentinel that you 

added.  One of the entries will be for the Listener Socket; the other entry will be for the 

Server Socket that was created by the Listener Socket when the connection was 

established.  The Listener’s socket/port information is identified by a port entry in the 

Port column that only contains the Listeners Socket’s port number (e.g., /6100/).  The 

Listener Socket’s port information identifies the number of connections or Server Sockets 

associated with the port.  The Server Socket’s port information is identified by a port 

entry that contains two values: the Listener Socket’s port number and the newly created 

Server Socket’s port number (e.g., /6100/1024).  The Server Socket’s port information is 

important because it is the port that is actually receiving and sending the TCP packets.  

 

 

 

Protocol 

The Protocol (e.g. TCP).  If you check the Protocol button, the Protocol column will be 

displayed.  All sentinel connections are TCP. 

 

Connections 

The number of connections that have been established by the port’s socket.  If you check 

the Connections button, the Conn column will be displayed. 

 

Seg Rcvd 

Seg Rcvd stands for Segments Received.  It is the number of TCP packet segments that 

arrived from the remote user system.  TCP may break apart or combine packets to form 

segments prior to transmitting data.  This column is only applicable for TCP. If you 

check the Seg Rcvd button, the Seg Rcvd column will be displayed. 

 

Seg Drop 

Seg Drop stands for Segments Dropped.  It is the number of TCP packet segments that 

arrived from the remote user system and were dropped.  TCP may break apart or combine 

packets to form segments prior to transmitting data.  This column is only applicable for 

TCP.  If you check the Seg Drop button, the Seg Drop column will be displayed. 

 

Pkts Rcvd 
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Pkts Rcvd stands for Packets Received.  It is the number of packets that arrived from the 

remote user system.  If you check the Pkts Rcvd button, the Pkts Rcvd column will be 

displayed. 

 

Rcvd Pkts Drop 

Rcvd Pkts Drop stands for Received Packets Dropped.  It is the number of packets that 

arrived from the remote user system and were dropped.  If you check the Rcvd Pkts Drop 

button, the Rcvd Pkts Drop column will be displayed. 

 

Connected To IP Address 

Identifies the IP Address that the sentinel is connected to.  If you check the Connected To 

IP Address button, the Connected To IP Address column will be displayed. 

 

Connected To Port 

Identifies the port that the sentinel is connected to.  If you check the Connected To Port 

button, the Connected To Port column will be displayed. 

 

 

 

6.17 Recorded Data Viewer Dialog 

The Recorded Data Viewer is used to view data that is stored in a TReK recording file.  

The Recorded Data Viewer can be used to view any type of TReK recording file:  ERIS 

messages, commanding messages, telemetry data, or sentinel messages.  The Recorded 

Data Viewer works in a Pulse mode.  The Recorded Data Viewer dialog is shown in 

Figure 19.  First you use the Configure dialog to identify the recording files you would 

like to view.  Then you can start the viewing session by pushing the Start button.  The 

Recorded Data Viewer will display the amount of data (messages/packets) based on the 

Pulse Rate that you identified in the Configure dialog.  Each time you would like to view 

the next set of data you push the Pulse button.  You can stop at any time by pushing the 

Stop button.  You can clear the display by pushing the Clear button.  Note the black box 

next to the Status field in Figure 19.  This box changes color based on the activity in 

progress.  For instance, it will be black when the Recorded Data Viewer has not been 

configured.  It will alternate between green and red once the Start button has been 

pushed.  It will turn green when data is available, and it will turn red when all the data 

has been played back and there is no more data available. 

 

 



TREK-USER-037 

 29 

 

Figure 19 Recorded Data Viewer Dialog 

 

 

Each field in the Recorded Data Viewer dialog is described below. 

 

Status 

This Status field displays a text message to indicate the status of the Recorded Data 

Viewer. 

 

Total Pkts/Msgs Received 

The Total Pkts/Msgs Received field displays the number of packets or messages that 

have been retrieved from the recording files.  This number will increment each time you 

push the Pulse button so you know the total number of packets or messages that have 

been viewed thus far. 

 

Packet ID 

This is an identifier that is associated with the recorded data.  For telemetry data this is 

the packet ID or APID.  This is N/A for ERIS, command, and sentinel data. 

 

 

 

Packet Type 

This is the packet type associated with the recorded data: ERIS, PDSS Payload, Suitcase 

Simulator, EHS Command, TReK (sentinel messages are tagged with a packet type of 

TReK), etc. 

 

Buttons 

There are several non-standard buttons on the Recorded Data Viewer dialog.  Each is 

described below. 

 

Configure 

The Configure button displays the Configure dialog which provides a way to identify the 

recording files you wish to view.  This dialog also provides a way to configure the pulse 

rate.  This dialog is discussed in Section 6.18. 
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Start/Replay 

The Start button is used to start a viewing session.  Once the recorded data viewing has 

started, you use the Pulse button to request more data.  If you push the Stop button or the 

recorded data viewing session completes (you hit the end of the recorded data files), then 

the Start button will be re-labeled Replay. At this point Replay will start the recorded data 

viewing session at the beginning (at the Start Time). 

 

Pulse 

The Pulse button will display the next set of data retrieved from the recording files. 

 

Stop  

The Stop button will stop the recorded data viewing session.  At this time you can replay 

the data or you can reconfigure the Recorded Data Viewer to view a different set of 

recording files. 

 

Clear 

The Clear button will clear all the text in the Recorded Data Viewer window. 

 

 

 

6.18 Configure (Recorded Data Viewer) Dialog 

The Configure dialog is shown in Figure 20.  You can only view one type of data at a 

time.  For example, you cannot identify recording files that contain ERIS messages and 

recording files that contain telemetry data.  If you identify more than one set of recording 

files, they must contain the same type of data.  Please note that the TReK Receipt 

Time/Spacecraft Time buttons are only used when working with recording files that 

contain telemetry data.  These buttons are ignored if the recorded data is ERIS data,  

commanding data, or sentinel data.  When viewing telemetry data all the data must be 

from the same packet ID (APID).  For example, you cannot view both Packet ID 7 and 

Packet ID 2 data at the same time.  If you are familiar with the Add A Playback Packet 

dialog then the Recorded Data Viewer may look somewhat familiar.  This is because the 

information you enter to work with the Recorded Data Viewer is similar to the 

information you would enter to set up a local TReK playback.  When you use the 

Recorded Data Viewer TReK is basically performing a playback.  However instead of the 

data being played back through your TReK system, it is only being made available for 

viewing in the Recorded Data Viewer dialog. 
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Figure 20 Configure (Recorded Data Viewer) Dialog 

 

 

Each field in the Configure (Recorded Data Viewer) dialog is described below. 

 

Retrieve Packets Based On (Required Field for Telemetry Data) 

This option tells your TReK system whether to use TReK Receipt Time or Spacecraft 

Time when telemetry packets are retrieved from the data recording files for viewing.  

Spacecraft Time refers to the Embedded Time that is located in the CCSDS secondary 

header for PDSS Payload packets and Suitcase Simulator packets.  Spacecraft Time can 

only be used when viewing telemetry data. 

 

Playback Stream List (Required Field) 

This playback stream list displays each set of recording files that you have identified.  For 

each set of recording files, the entry will show the Start Time, Stop Time, Packet ID, and 

Packet Type associated with those recording files. 

 

 

Ordering (Required Field) 

Ordering identifies the ordering that TReK should use when displaying the data that has 

been retrieved from the recording files.  For example, you can select to display the data in 

the order it was received, display the data after it has been reordered based on time, or 

display the data after it has been reordered based on time and all duplicates have been 

removed.  Duplicates can occur if you have identified multiple sets of recorded data that 

overlap in time.  This can occur if you are working with recording files that contain both 

realtime data and dump data.  There may be some timeframe in which the same packets 

were recorded in both sets of recording files.  In this situation you may want to identify 
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both sets of recording files in order to merge them together into one contiguous time 

frame, but you want to remove any duplicates that were the result of the time overlap. 

 

Note:  When working with ERIS data files, command data files, or sentinel data files please 

select ‘Playback In The Order Received’.  Since these types of data do not contain a 

sequence count or an embedded time, these packets cannot be re-ordered.  

 

 

Pulse Rate (Pkts/Pulse)  (Required Field) 

The number of packets or messages to display each time the Pulse button is pushed. 

 

Buttons 

There are several non-standard buttons on the Configure Recorded Data Viewer dialog.  

Each is described below. 

 

Add 

The Add button displays the Add dialog described in 6.19.  It is used to add information 

about a set of TReK recording files. 

 

Browse 

The Browse button displays the Windows Open dialog which can be used to select one or 

more TReK recording files. 

 

Modify 

The Modify button is only available when an item in the list is selected.  Modify provides 

a way to edit an item in the list.  If you push the Modify button a dialog identical to the 

Add dialog described above (except for the title) will be displayed. 

 

Delete 

The Delete button is only available when an item in the list is selected.  Delete provides a 

way to delete an item from the list. 

 

 

6.19 Add (Configure Recorded Data Viewer) Dialog 

The Add dialog is shown in Figure 21.  This dialog provides a way to identify one set of 

recording files. 
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Figure 21 Add (Configure Recorded Data Viewer) Dialog 

 

Each field in the Add (Configure Recorded Data Viewer) dialog is described below. 

 

Start Time  (Required Field) 

The Start Time information tells your TReK system where to start the recorded data 

viewing.  You can choose to start the viewing at any location within the time span 

associated with the recorded data.   The start time does not have to be an exact match 

with the start time on any of the files.  It can be any time before or after the start time on 

the first file.  Please remember that the Start Time is a TReK receipt time for ERIS data, 

command data, and sentinel data. 

 

Stop Time (Required Field) 

The Stop Time information tells your TReK system where to stop the playback.  You can 

choose to stop the recorded data viewing at any location within the time span associated 

with the recorded data.   The stop time does not have to be an exact match with the stop 

time on any of the files.  It can be any time after the start time on the first file.  Please 

remember that the Stop Time is a TReK receipt time for ERIS data, command data, and 

sentinel data. 

 

Original Base Filename (Required Field) 

The Original Base Filename field is used to tell your TReK system the Base Filename 

you used when you originally recorded the data.  Be sure to enter exactly what you 

entered when you originally recorded the data.  For example, if you used the name “eris” 

for the Base Filename when you recorded the data, then you should enter “eris” in the 

Original Base Filename field.  (Note:  File extensions are not required but they are 

allowed.) 

 

Original Recorded Data Directory (Required Field) 

The Original Recorded Data Directory field is used to tell your TReK system where the 

original data recording files are stored.  This field requires a complete directory path. An 

example of this is C:\MyRecordingFiles\.  If you don’t like to type or you need help 

defining the complete path, you can push the … (dot dot dot) button located to the right 

of the Original Recorded Data Directory field.  This will bring up a Windows Browse for 

Folder dialog which you can use to identify the local directory path where your recorded 
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data files are stored.  The Browse for Folder dialog is not described in this document 

since it is a typical Windows dialog box.  If you need help with this dialog, please refer to 

your Windows on-line help. 

 

 

6.20 Deactivate Sentinel Warning Message Dialog 

The Deactivate Sentinel Warning message dialog will appear if you attempt to deactivate 

a sentinel from the sentinel list in the main window.  If you are sure you want to proceed 

answer Yes.  If you do not want to proceed answer No and no action will be taken. 

 

 

 

Figure 22 Deactivate Sentinel Warning Message Dialog 

 

 

6.21 Delete Sentinel Warning Message Dialog 

The Delete Sentinel Warning message dialog will appear if you attempt to delete a 

sentinel from the sentinel list in the main window.  If you are sure you want to proceed 

answer Yes.  If you do not want to proceed answer No and no action will be taken. 

 

 

Figure 23 Delete Sentinel Warning Message Dialog 

 

 

 

6.22 Invalid Configuration Information Dialog 

The Invalid Configuration Information dialog is shown in Figure 24.  This dialog appears 

only if you attempt to open a configuration file that contains invalid configuration 

information.  This usually happens when you move a configuration file from one machine 

to another.  For example, when you save a configuration file, the sentinels and all the 



TREK-USER-037 

 35 

information associated with the sentinels (including the IP address information) are 

stored in the configuration file.  If you move the configuration file, then some of this 

information will no longer be valid. 

 

The Invalid Configuration Information dialog contains two lists.  The list at the top of the 

dialog contains a list of the sentinels that are stored in the configuration file.  If the 

sentinel contains any invalid information it will be red.  When you select a sentinel in the 

sentinel list, the list located below the sentinel list will display all the invalid items 

associated with that particular sentinel.   

 

 

 

Figure 24 Invalid Configuration Information Dialog 

 

 

Buttons 

 

Modify 

When you select a sentinel in the sentinel list and push the Modify button, the Sentinel 

Properties dialog will be displayed.  The Sentinel Properties dialog can be used to change 

the properties that are invalid. 

 

Delete 

Selecting the Delete button will delete the sentinel from the configuration.  The 

configuration file will not be changed unless you perform a save after the configuration 

file has been successfully opened. 
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Cancel 

Selecting the Cancel button will abort the entire process and leave the configuration file 

unchanged. 

 

 

6.23 Close Configuration Warning Message Dialog 

The Close Configuration Warning message dialog will appear if you attempt to perform a 

New or Open and there are sentinels in the sentinel list.  If you are sure you want to 

proceed answer Yes.  If you do not want to proceed answer No and no action will be 

taken. 

 

 

Figure 25 Close Configuration Warning Message Dialog 

 

 

6.24 Save Changes Message Dialog 

The Save Changes message dialog will be displayed when you close the current 

configuration by selecting New, Open, or Exit.  The Save Changes message dialog 

provides a way to save the current configuration before closing it. 

 

 

Figure 26 Save Changes Message Dialog 

 

 

6.25 Exit Confirmation Message Dialog 

The Exit Confirmation message dialog is displayed to help you avoid exiting the Remote 

Services application by accident.  It will be displayed only if you exit the application with 

the current configuration unchanged.  If the configuration has changed, you will be 

prompted with the Save Changes dialog instead of the Exit Confirmation dialog.  If you 

are prompted with the Exit Confirmation dialog and you are sure you want to exit, answer 
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Yes.  If you do not want to exit the application, answer No and the application will not 

proceed with the exit. 

 

 

 

Figure 27 Exit Confirmation Message Dialog 

 

 

7 Special Topics 

There are no special topics at this time. 
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Appendix A Glossary 
Note:  This Glossary is global to all TReK documentation.  All entries listed may not be 

referenced within this document. 

 

Application Programming Interface 

(API) 

A set of functions used by an application program 

to provide access to a system’s capabilities. 

 

Application Process Identifier 

(APID) 

An 11-bit field in the CCSDS primary packet 

header that identifies the source-destination pair 

for ISS packets. The type bit in the primary header 

tells you whether the APID is a payload or system 

source-destination. 

 

Calibration The transformation of a parameter to a desired 

physical unit or text state code. 

 

Communications Outage Recorder System that captures and stores payload science, 

health and status, and ancillary data during TDRSS 

zone of exclusion. 

 

Consultative Committee for Space  

Data Systems (CCSDS) format 

Data formatted in accordance with 

recommendations or standards of the CCSDS. 

 

Consultative Committee for Space  

Data Systems (CCSDS) packet 

A source packet comprised of a 6-octet CCSDS 

defined primary header followed by an optional 

secondary header and source data, which together 

may not exceed 65535 octets. 

 

Conversion Transformation of downlinked spacecraft data 

types to ground system platform data types. 

 

Custom Data Packet A packet containing a subset of parameters that 

can be selected by the user at the time of request. 

 

Cyclic Display Update Mode A continuous update of parameters for a particular 

display. 

 

Decommutation (Decom) Extraction of a parameter from telemetry. 

 

Discrete Values Telemetry values that have states (e.g., on or off). 
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Dump During periods when communications with the 

spacecraft are unavailable, data is recorded 

onboard and played back during the next period 

when communications resume.  This data, as it is 

being recorded onboard, is encoded with an 

onboard embedded time and is referred to as dump 

data. 

 

Enhanced HOSC System (EHS) Upgraded support capabilities of the HOSC 

systems to provide multi-functional support for 

multiple projects. It incorporates all systems 

required to perform data acquisition and 

distribution, telemetry processing, command 

services, database services, mission support 

services, and system monitor and control services. 

 

Exception Monitoring A background process capable of continuously 

monitoring selected parameters for Limit or 

Expected State violations. Violation notification is 

provided through a text message. 

 

Expected State Sensing Process of detecting a text state code generator in 

an off-nominal state. 

 

EXPRESS An EXPRESS Rack is a standardized payload rack 

system that transports, stores and supports 

experiments aboard the International Space 

Station. EXPRESS stands for EXpedite the 

PRocessing of Experiments to the Space Station. 

 

File transfer protocol (ftp) Protocol to deliver file-structured information from 

one host to another. 

 

Flight ancillary data A set of selected core system data and payload 

health and status data collected by the USOS 

Payload MDM, used by experimenters to interpret 

payload experiment results. 
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Grayed out Refers to a menu item that has been made 

insensitive, which is visually shown by making the 

menu text gray rather than black.  Items that are 

grayed out are not currently available. 

 

Greenwich Mean Time (GMT) The solar time for the meridian passing through 

Greenwich, England.  It is used as a basis for 

calculating time throughout most of the world. 

 

Ground ancillary data A set of selected core system data and payload 

health and status data collected by the POIC, 

which is used by experimenters to interpret 

payload experiment results.  Ground Ancillary 

Data can also contain computed parameters 

(pseudos). 

 

Ground receipt time Time of packet origination. The time from the 

IRIG-B time signal received. 

 

Ground Support Equipment (GSE) GSE refers to equipment that is brought in by the 

user (i.e. equipment that is not provided by the 

POIC). 

 

Ground Support Equipment Packet A CCSDS Packet that contains data extracted from 

any of the data processed by the Supporting 

Facility and the format of the packet is defined in 

the Supporting Facility’s telemetry database. 

 

Huntsville Operations Support 

Center (HOSC) 

A facility located at the Marshall Space Flight 

Center (MSFC) that provides scientists and 

engineers the tools necessary for monitoring, 

commanding, and controlling various elements of 

space vehicle, payload, and science experiments. 

Support consists of real-time operations planning 

and analysis, inter- and intra-center ground 

operations coordination, facility and data system 

resource planning and scheduling, data systems 

monitor and control operations, and data flow 

coordination. 
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IMAQ ASCII A packet type that was added to TReK to support a 

very specific application related to NASA’s Return 

to Flight activities.  It is not applicable to ISS.  It is 

used to interface with an infrared camera that 

communicates via ASCII data. 

 

Limit Sensing Process of detecting caution and warning 

conditions for a parameter with a numerical value. 

 

Line Outage Recorder Playback A capability provided by White Sands Complex 

(WSC) to play back tapes generated at WSC 

during ground system communication outages. 

 

Measurement Stimulus Identifier 

(MSID) 

Equivalent to a parameter. 

 

 

Monitoring A parameter value is checked for sensing 

violations. A message is generated if the value is 

out of limits or out of an expected state. 

Parameter TReK uses the generic term parameter to mean any 

piece of data within a packet.  Sometimes called a 

measurement or MSID in POIC terminology. 

 

Payload Data Library (PDL) An application that provides the interface for the 

user to specify which capabilities and requirements 

are needed to command and control his payload. 

 

Payload Data Services Systems 

(PDSS) 

The data distribution system for ISS.  Able to route 

data based upon user to any of a number of 

destinations. 

 

Payload Health and Status Data Information originating at a payload that reveals 

the payload’s operational condition, resource 

usage, and its safety/anomaly conditions that could 

result in damage to the payload, its environment or 

the crew. 

 

Payload Operations Integration 

Center (POIC) 

Manages the execution of on-orbit ISS payloads 

and payload support systems in 

coordination/unison with distributed International 

Partner Payload Control Centers, Telescience 

Support Centers (TSC’s) and payload-unique 

remote facilities. 
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Payload Rack Checkout Unit 

(PRCU) 

The Payload Rack Checkout Unit is used to verify 

payload to International Space Station interfaces 

for U.S. Payloads. 

 

Playback Data retrieved from some recording medium and 

transmitted to one or more users. 

 

Pseudo Telemetry (pseudo data) Values that are created from calculations instead of 

directly transported telemetry data.  This pseudo 

data can be created from computations or scripts 

and can be displayed on the local PC. 

 

Remotely Generated Command A command sent by a remote user whose content 

is in a raw bit pattern format.  The commands 

differ from predefined or modifiable commands in 

that the content is not stored in the POIC Project 

Command Database (PCDB). 

 

Science data Sensor or computational data generated by 

payloads for the purpose of conducting scientific 

experiments. 

 

Subset A collection of parameters from the total 

parameter set that is bounded as an integer number 

of octets but does not constitute the packet itself.  

A mini-packet. 

 

Super sampled A parameter is super sampled if it occurs more 

than once in a packet. 

 

Swap Type A flag in the Parameter Table of the TReK 

database that indicates if the specified datatype is 

byte swapped (B), word swapped (W), byte and 

word swapped (X), byte reversal (R), word 

reversal (V) or has no swapping (N). 

 

Switching A parameter’s value can be used to switch between 

different calibration and sensing sets.  There are 

two types of switching on TReK:  range and state 

code. 
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Transmission Control Protocol 

(TCP) 

TCP is a connection-oriented protocol that 

guarantees delivery of data. 

 

Transmission Control Protocol 

(TCP) Client 

A TCP Client initiates the TCP connection to 

connect to the other party. 

 

Transmission Control Protocol 

(TCP) Server 

A TCP Server waits for (and accepts connections 

from) the other party. 

 

Telemetry Transmission of data collected form a source in 

space to a ground support facility. Telemetry is 

downlink only. 

 

Telescience Support Center (TSC) A TSC is a NASA funded facility that provides the 

capability to plan and operate on-orbit facility 

class payloads and experiments, other payloads 

and experiments, and instruments. 

 

User Application Any end-user developed software program that 

uses the TReK Application Programming Interface 

software.  Used synonymously with User Product. 

 

User Data Summary Message 

(UDSM) 

Packet type sent by PDSS that contains 

information on the number of packets sent during a 

given time frame for a PDSS Payload packet.  For 

details on UDSM packets, see the POIC to Generic 

User IDD (SSP-50305). 

 

Uplink format The bit pattern of the command or file uplinked. 

 

User Datagram Protocol (UDP) UDP is a connection-less oriented protocol that 

does not guarantee delivery of data.  In the TCP/IP 

protocol suite, the UDP provides the primary 

mechanism that application programs use to send 

datagrams to other application programs.  In 

addition to the data sent, each UDP message 

contains both a destination port number and a fully 

qualified source and destination addresses making 

it possible for the UDP software on the destination 

to deliver the message to the correct recipient 

process and for the recipient process to send a 

reply. 
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User Product Any end-user developed software program that 

uses the TReK Application Programming Interface 

software. Used synonymously with User 

Application. 

 

Web Term used to indicate access via HTTP protocol; 

also referred to as the World Wide Web (WWW). 
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Appendix B Acronyms 
Note:  This acronym list is global to all TReK documentation.  Some acronyms listed 

may not be referenced within this document. 

 

AOS   Acquisition of Signal 

API   Application Programming Interface 

APID   Application Process Identifier 

ASCII   American Standard Code for Information Interchange 

CAR   Command Acceptance Response 

CAR1   First Command Acceptance Response 

CAR2   Second Command Acceptance Response 

CCSDS  Consultative Committee for Space Data Systems 

CDB   Command Database 

CDP   Custom Data Packet 

COR   Communication Outage Recorder 

COTS   Commercial-off-the-shelf 

CRR   Command Reaction Response 

DSM   Data Storage Manager 

EHS   Enhanced Huntsville Operations Support Center (HOSC) 

ERIS   EHS Remote Interface System 

ERR   EHS Receipt Response 

EXPRESS  Expediting the Process of Experiments to the Space Station 

ES   Expected State 

FAQ   Frequently Asked Question 

FDP   Functionally Distributed Processor 

FSV   Flight System Verifier 

FSV1   First Flight System Verifier 

FSV2   Second Flight System Verifier 

FPD   Flight Projects Directorate 

FTP   File Transfer Protocol 

GMT   Greenwich Mean Time 

GRT   Ground Receipt Time 

GSE   Ground Support Equipment 

HOSC   Huntsville Operations Support Center 

ICD   Interface Control Document 

IMAQ ASCII  Image Acquisition ASCII 

IP   Internet Protocol 

ISS   International Space Station 

LDP   Logical Data Path 

LES   Limit/Expected State 

LOR   Line Outage Recorder 

LOS   Loss of Signal 

MCC-H  Mission Control Center – Houston  

MOP   Mission, Operational Support Mode, and Project 

MSFC   Marshall Space Flight Center 

MSID   Measurement Stimulus Identifier 
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NASA   National Aeronautics and Space Administration 

OCDB   Operational Command Database 

OS   Operating System 

PC   Personal Computer, also Polynomial Coefficient 

PCDB   POIC Project Command Database 

PDL   Payload Data Library 

PDSS   Payload Data Services System 

PGUIDD  POIC to Generic User Interface Definition Document 

POIC   Payload Operations Integration Center 

PP   Point Pair 

PRCU   Payload Rack Checkout Unit 

PSIV   Payload Software Integration and Verification 

RPSM   Retrieval Processing Summary Message 

SC   State Code 

SCS   Suitcase Simulator 

SSP   Space Station Program 

SSCC   Space Station Control Center 

SSPF   Space Station Processing Facility 

TCP   Transmission Control Protocol 

TReK   Telescience Resource Kit 

TRR   TReK Receipt Response 

TSC   Telescience Support Center 

UDP   User Datagram Protocol 

UDSM   User Data Summary Message 

URL   Uniform Resource Locator 

USOS   United States On-Orbit Segment 

VCDU   Virtual Channel Data Unit 

VCR   Video Cassette Recorder 

VPN   Virtual Private Network 

 


